Using Multimedia Tutorials to Enhance Student Learning of
File Management for Adult Beginner Computer Users

Tiffany Akiyama
University of Hawaii, Manoa
Department of Educational Technology
Honolulu, HI, USA
twjsakiy@hawaii.edu

Abstract: The purpose of this project was to develop and assess the
effectiveness of multimedia modules assisting the learning of file management
(FM) skills for adults at least 50 years of age. Older adults are capable of
learning modern technologies but experience anxiety and physiological problems
that may interfere with their learning of new skills. The incorporation of
multimedia in lessons will provide multiple cues for adults to better understand
new information when learning. The target population for this study was adults
at least 50 years of age who have very little or no experience with a computer.
The sample population represented a demographic cross-section of adults age 50
years or older with variations of FM skill level. Participants were given a self-
directed multimedia packet to take home and learn FM. Survey results showed
most participants found the multimedia tutorials useful in enhancing learning and
that tutorials should be implemented in class lessons for adult beginner computer
users. Overall, improvements in both post-test results, and correct completion of
a FM activity indicated that multimedia modules were successful in teaching FM.

Introduction

Currently, adult learners enter a technological world of learning that is different from the
world they encountered a decade ago. According to Stacy Takeshita (personal
communication, April 27, 2008), instructor of Computer I and II at Kaimuki Community
Adult School, “File Management (FM) is a critical component of introductory adult
computer courses and is one of the most difficult skills for older adults to learn.” The
purpose of this project is to develop and assess effectiveness with the use of multimedia
modules to assist in retention of learned FM skills for adults at least 50 years of age.

Background

Older adults often have difficulties using current technology due to a common set of
barriers (Hutchison, Eastman, & Tirrito, 1997). Birren and Warner (1990) explained that
these barriers are common physiological changes that occur with aging that may limit an
older adult’s success at using technology. These changes include vision problems
(Hanson, 2001), decline in hearing (Montano, 2003), muscular challenges (Davis, 2001),
and difficulties with working memory (Van Gerven, Paas, Van Merriënoer, Hendricks,
& Schmidt, 2003; Davis, 2001) which results in difficulty of retaining what they have
learned (Burton-Jones & Hubona, 2005; Cutler, 2005; Davis, 2001).
Problems with vision seem to pose the greatest challenge (Hanson, 2001, 2004). Conditions such as presbyopia can make reading a monitor with small fonts or using a keyboard difficult (Davis, 2001). Muscular challenges such as arthritis and reduced dexterity can impact the use of a keyboard or mouse (Rogers & Fisk, 2002, Davis, 2001). The affects of arthritis may cause older adults to be slower when clicking with a mouse which makes it difficult to hit a target with the mouse (Meyer, 1998). Difficulties with working memory may make it difficult for older adults to organize related concepts in a meaningful way by the manner in which it will be used, which may cause the learner to become overwhelmed with information leading to poor performance (Czaja & Sharit, 1993; Gilinsky & Judd, 1994). As a result older adults require more time to learn the technology, make more errors, and require more help (Czaja & Sharit, 1993, Kelley & Charness, 1995).

To account for physiological decline, learning aids should incorporate multiple cues to assist older adults with new information. Rogers, Campbell and Pak (2001) suggest that the multiple cues to support older adult learners include repetitive practice, illustrated instructions, and descriptions, of which are all aspects of multimedia. Multimedia consists of synchronized verbal and visual presentations of items (Qiu, 2003). This format allows designers to present material audiovisually (Van Gerven, Paas, & Tabbers, 2006). Audiovisual lessons are cognitively efficient because it limits visual search between images and text, minimizes overload on visual and audio components of working memory (Van Gerven, Paas, & Tabbers, 2006), and allows information to be encoded verbally and nonverbally, which increases the chance of turning working memory into long term memory (Clark & Paivio, 1991).

Research has shown that students who learn from multimedia, score significantly higher than their counterparts (Lodree, 2005; Mayer, 2001; Mayer & Anderson, 1991, 1992). For instance, a study conducted by Mayer and Anderson (1991, 1992) demonstrated how brakes or pumps worked through lessons given with narration and animation, or by narration only. The results showed that students who learned with a narration and animation lesson scored significantly higher than students who learned with a narration-only lesson. Other studies incorporated the use of pictures as static images and printed text lessons and text only lessons to compare the effectiveness of each lesson (Collins, 2007; Mayer, 2001). Results from these studies also demonstrated that students who learned with text only lessons did not score as high as their counterparts who learned with a multimedia lesson.

Other recommendations to assist older individuals learning computer skills are to use simple language to lower the load on working memory and slower or self-paced instruction (Morrell and Echt, 1996). Other researchers have also stressed the importance of text appearance such as font type or font size (Morrell & Echt, 1997), and the use of illustrations (Morrell & Park, 1993).
Methodology

Multimedia Tutorial Development

The FM tutorials were designed to provide adult beginner computer users 50 years of age or older with information, demonstrations, guided practice, and descriptions of FM. Adobe Photoshop was used to color and design any graphics used in the tutorials. Microsoft PowerPoint was used to create the textual information in the tutorials. The tutorials were primarily created with Adobe Captivate to provide an audio, visual, and psychomotor learning experience for adults with physiological challenges.

Adobe Captivate assisted with the production of onscreen-action-capture videos of different FM skills. Pop-up text cues were used when FM skills were demonstrated, and when the participant was asked to practice the demonstrated skill. Embedded test questions were included after each section and feedback for all embedded test questions was provided to participants to enhance retention and understanding. Voice narration was recorded throughout the entire length of each tutorial to provide participants with audio cues.

At the beginning of each tutorial, the goals were explained and a video explanation of how to use a mouse was demonstrated. Each tutorial consisted of five sections, and each section consisted of at least one PowerPoint slide with a list of key points. After each section there were three embedded multiple choice questions with feedback to enhance learning and retention. All text elements were displayed as sans-serif fonts size fourteen point or higher to increase visibility. Throughout the tutorials, voice narration was recorded to describe the key points and to describe the demonstrations step-by-step. Presentation of material for both tutorials was designed at a slow enough pace for adults 50 years of age or older to follow along and process information.

Tutorial 1 went over: components of a file name, functions of a folder, different computer drives, file structure, and how to use Windows Explorer. Four of the five sections had video demonstrations, and of those four sections, two sections included guided practice of a demonstrated skill. One section did not include video demonstration because the same concepts explained and demonstrated in the previous section applied to the section without video demonstration.

Tutorial 2 covered how to: create, move, copy, delete, and rename files and folders. All sections had video demonstrations, followed by guided practice of what was demonstrated, and then a secondary guided practice asking the participant to apply the skill that was just learned to a second set of verbal instruction. Three sections had a ‘Quick Tip’ section before the embedded review questions to include information that was difficult to provide a guided practice without errors or was neglected to be included in the original narration.

The tutorials included basic forward, backward, and pause buttons that allowed participants to backtrack, advance forward, or stop during the tutorial. Both tutorials
were designed to run automatically after each slide to allow participants to concentrate on the presented material rather than concentrating on how to navigate through the tutorial.

**Formative Evaluation**

To assess the effectiveness of the multimedia tutorials 30 take-home test packets were distributed to interested individuals. The packet included paper instructions of what to do with the take-home packet, two paper consent forms, a CD, two paper pre-test quizzes, two paper post-test quizzes, a FM checklist activity sheet, and a paper questionnaire. The CD included FM Tutorial 1 (auto-run), FM Tutorial 2, and a Hobbies folder for the FM activity. Participants who choose to participate were asked to sign one consent form and was given a week to complete the pre-tests, post-tests, tutorials, FM activity, and the evaluation form.

Participants were recruited from Kaimuki Community Adult School, Queen Kapiolani Hospital, Hawaii Residency Program, Hawaiian Airlines, State of Hawaii Department of Public Safety, and small or private businesses. All qualified participants were 53 to 70 years of age. About half of the participants had some prior knowledge of FM, and a few had very little experience with computers.

Evaluation of the tutorials was conducted by collecting quantitative data. Data were collected to evaluate participant attitudes about multimedia tutorials, opinion and effectiveness of the tutorials, and assessment of participant retained understanding of FM.

Participants were first asked to complete a pre-test for FM Tutorial 1 to collect data on their prior knowledge of FM. The pre-test consisted of five multiple choice questions related to information from FM Tutorial 1. Next participants were asked to complete a 25 minute tutorial. After completion of the tutorial, participants were asked to take a post-test to determine if the tutorial aided in learning FM. The post-test consisted of five multiple choice questions related to information from the tutorial. Participants were asked to repeat this process with FM Tutorial 2. FM Tutorial 2 was designed to take 30 minutes.

After completion of the tutorials participants were asked to complete an 11 item paper FM checklist activity designed to take less than 10 minutes. If a task listed on the FM checklist activity was completed, the participant was asked to check that item off. This activity asked the participants to move, copy, rename, and delete files and folders in a folder named Hobbies that was provided on the CD. After the FM tasks were completed, the participants were asked to draw a structural representation of the folder on the back of the FM checklist activity paper to see if there was a gained understanding of FM and how to do FM.

Lastly, participants were asked to complete a 19 question paper attitudinal survey questionnaire designed to take less than 20 minutes. The questionnaire asked for the participant’s age to determine if the participant qualified as the target population for the research project. There were 17 Likert-scale questions on the tutorials’ design, the
participants’ experience and opinion about multimedia tutorials. There was also one open-ended question asking for suggestions for improvement. All data collected were anonymous to maintain participant confidentiality. A unique identifier was used for each packet of data, but the identifier did not link to the participant’s name.

Findings and Results

Of the 30 packets that were distributed, 17 packets were returned by the end of the week, and data were collected from 14 of the 17 packets. Two participants did not meet the age for the target population for the research study, and one participant dropped out. The majority of participants were 53 to 62 years old, with the oldest participant 70 years old. The majority (57%) of participants had prior FM knowledge, and after completion of the tutorials, a high majority (86%) expressed an increased knowledge of FM. The remaining 14 percent were unsure.

Pre- and post-test

Pre-test and post-test results for both tutorials showed that participants’ correct responses increased for a majority of the test questions. Tutorial 1 pre-test and post-test results, illustrated in Figure 1, displayed an increase in correct responses for four test questions, with one test question remained identical. For two post-test questions, 100 percent of participants identified the correct answer, while the remaining two questions had a correct response rate of 64 percent and a correct response rate of 93 percent. Tutorial 2 pre-test and post-test results illustrated in Figure 2 displayed an increase in correct responses for four test questions, with one test question having an eight percent decrease in correct responses. Of the four test questions with an increase in correct answers there was a correct response rate that varied from 62 percent to 92 percent.

![Figure 1. Tutorial 1 pre-test versus post-test results.](image-url)
After reviewing FM Tutorial 2’s section on renaming files and folders, the researcher postulates that the drop in correct responses for Question 4 could be due to a problem with the multiple-choice options. Question 4 asks:

All of the following are steps used to rename a file or folder EXCEPT:
   a. Select the file or folder.
   b. Left click on the file or folder.
   c. Press Enter on the keyboard.
   d. Left click on the Edit menu.

Of the nine participants who answered this question incorrectly, one chose ‘A,’ five chose ‘B,’ and four chose ‘C.’ The section in FM Tutorial 2 that covered renaming files and folders explained each step using both words, ‘Select,’ and ‘Left click.’ For example, “Select the folder by left clicking on the file…” was recorded in the narration. A possible explanation for a participant to choose ‘A’ or ‘B’ is that the participant was not able to correlate ‘Select’ and ‘Left click’ as related concepts in their working memory. A reason that participants may have chose ‘C’ could be that most of the guided practice involved mouse clicks and very little use of the keyboard except for typing file or folder names that the ‘Enter button’ on the keyboard was not associated as a step in renaming files or folders in their working memory. If the participant did not create a link to a step in their working memory, it is most likely that step was forgotten. After further review of the tutorial, a possible explanation for the nine participants who answered Question 4 incorrectly could be that the tutorial did not explicitly explain NOT to ‘Left click on the Edit menu.’ According to Stacy Takeshita (personal communication, April 27, 2008), instructor of Computer I and II at Kaimuki Community, students commonly made mistakes by left clicking on the Edit menu instead of the File menu when trying to rename files or folders since they may automatically create a link to rename as a form of
editing. Therefore they may have forgotten that the Rename option is located in the File menu.

**FM checklist activity**

The FM checklist activity is a practice activity that included checklist items for the participant to check-off after completion. The activity revealed that half of the participants were able to successfully access the Hobbies folder from the CD. The other half had a ‘Read-Only’ error message appear when trying to access the Hobbies folder on the CD which prevented any editing of the folder. Of the participants who completed the FM checklist activity, 86 percent successfully drew a complete structural representation of the completed FM activity folder to include folders, subfolders, and files. The remaining 14 percent only included folders and subfolders in their FM structure.

**Attitudinal survey**

The majority of participants felt comfortable using the tutorials and found navigation to be easy. A high majority (93%) found pop-up text cues helped them the most with learning FM, while 7 percent were unsure. Voice narration was found helpful by 79 percent of the participants while 7 percent did not find voice narration helpful, and 14 percent were unsure. Seventy-nine percent of participants also found onscreen-action-capture videos helpful when they learned FM, while the rest (21%) of the participants were unsure if the videos were helpful. Text was found to be helpful by 64 percent of the participants while 14 percent of the participants did not find the text helpful, and 22 percent were unsure. All participants agreed that the tutorials’ design were easy to follow with the text size, volume, speed of narration, and color of text.

Overall, a majority (85%) of participants found multimedia tutorials helpful to learn FM and thought tutorials would be useful as part of class lessons. The remaining (15%) participants were unsure if the tutorials were helpful to learn FM or if tutorials should be a part of class lessons. Seventy-nine percent of participants felt the tutorials enhanced their learning experience, while the rest (21%) of the participants were unsure. Of the participants who did not have prior knowledge of FM, 83 percent felt the tutorials enhanced their learning, were helpful in learning FM, and also thought tutorials would be helpful as part of class lessons. The remaining 17 percent of beginner participants were unsure if the multimedia tutorials enhanced their learning, were helpful, or if multimedia tutorials should be used as part of class lessons.

After completion of the multimedia tutorials a majority (62%) preferred to learn with tutorials, whereas 38 percent were unsure. Sixty-seven percent of beginner participants preferred to learn with tutorials while 33 percent were unsure. Fifteen percent of the participants still preferred to learn face-to-face with an instructor, where 23 percent no longer preferred face-to-face instruction and the rest (62%) were unsure. A similar response was given by the beginner participants. Seventeen percent still preferred face-to-face instruction, while 7 percent no longer preferred this type of instruction, and 67 percent of beginner participants were unsure.
Implications

For this study, designers and developers of adult computer education courses can see that by incorporating pop-up text cues, voice narration, and videos with text, older adults 50 years or older had an easier time learning new computer skills. The combination of different multimedia can also help adult learners by providing different cues about the new content, making it easier for older adults to understand.

Designers and developers should also take into account common errors that may come from the target audience. Common errors should be explicitly explained in voice narration and or text so that there is a possibility of the learner creating a correlation of the common mistake as being wrong in their working memory. By doing so, it may help to limit additional errors.

For instructors, implementing multimedia tutorials as part of the curriculum will provide “practical exercise” as commented by one participant, and offer different cues about the new content that older adults will be able to understand then from just words alone (Mayer, 2001). In addition to class lessons, homework, quizzes, and tests, instructors may want to consider providing a copy of the tutorials on CD or on the web so that the tutorials are accessible at all times. As expressed by one participant, “the CD is good because it allows for assistance outside of class, and allows for multiple review of material.”

Conclusion

According to the results of this research, multimedia tutorials enhanced student learning of basic computer skills. The tutorials were helpful with aiding older adults in learning the new material because the tutorials provided multiple cues for adults to grasp information. This type of learning aid can be beneficial to students who may be experiencing physiological changes, since it can decrease computer anxiety, a primary barrier that prevents older adults from achieving proficient computer skills (Karavidas, Lim, & Katsikas, 2005; Laguna & Babcock, 1997; Reed, Doty, & May, 2005, White & Weatherall, 2000; Wright, 2000).

Learning new technology can be frightening to older adults especially if they are experiencing physiological changes that occur with aging. It is important to provide an accommodating learning environment to limit the frustration and anxiety that may occur. Based on this research, the presence of different multimedia cues in the tutorial helped older adult learners to understand the new content in comparison to just words alone (Mayer, 2001). Therefore, based on these findings, using multimedia tutorials that incorporate pop-up text cues, voice narration, and videos to accommodate text can be effective and beneficial to older adults learning basic computer skills.
References


